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The updates from the first version, published in November 2001,
are as follows:

• Stronger emphasis has been put on the need to keep all
resource files in one folder, despite the fact that Powerpoint
files are self-contained.

• Cropping and resizing of symbol images can be carried out
directly in Powerpoint itself, so there is no need to use inter-
mediary graphics software.

• The Custom Animation dialogue boxes differ significantly in
Powerpoint 97 and 2000, so both have been shown.

Richard Walter is the IT co-ordinator and a teacher at Meldreth
Manor School, a Scope school for pupils with cerebral palsy and
severe or profound learning difficulties.

He has written and contributed to several books and articles on
teaching pupils with special educational needs including IT for
All and The Internet for All published by David Fulton.
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Part 1:
Introduction

What is the purpose of this guide?
Like it’s title suggests, this guide gives you step-by-step instructions on how to use Microsoft’s
Powerpoint to create mouse-operated talking books using pictures scanned in from real books.
It will also look at accessing these talking books using a single switch.

Why do we need talking books?
Access to literature is of crucial importance in the education of all pupils, including those with
special educational needs. There has been a great expansion in the use of storybooks in
schools with a large number of reading books linked to the National Literacy Strategy. The pro-
liferation of big books for group reading and the opening up of literacy into more stimulating
and colourful reading books have especially helped in this expansion into special education.

There are, however, a number of pupils who cannot read independently because of their
physical difficulties. They cannot turn to the next page of a book, skip ahead to find ‘the excit-
ing bits’ or turn back to re-read a page.  They always have to ask someone else to hold their
books and turn the pages for them. Their reading development is often delayed, even if they
are of normal intelligence.

Most of the children visiting the ACE centre can, like our patron Professor Stephen Hawking,
independently access reading materials or books via one or two switches attached to a comput-
er. Children can access electronically published books using a variety of computer access aids
including activating a switch with whatever part of their body has the best voluntary control.
Unfortunately, the range of electronically available books for children is very limited and for
disabled children to develop as readers, they need access to the same range of books as other
children. 

It is, however, now possible to create your own books on the computer using hardware and
software that is generally available in schools and many homes. These ‘talking books’ can be
tailor-made to the interests and abilities of the pupils, text can be symbol-supported, and
sounds and speech can be included to enable access to those with reading difficulties.

Children can actively help to make their own accessible talking books, and this opens up
more possibilities of creative and imaginative writing for pupils with learning difficulties.
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A well-known example of talking books
is produced by Sherston Software as
the Oxford Reading Tree series (an
example is shown on the right). The
page layout is simple and consistent,
and the controls are clear and straight-
forward. We shall be using a similar
layout to construct our own talking
books.

Our books will be set up initially for
operation by positional mouse switch-
ing, where the left mouse button has

to be pressed when the mouse arrow is over the active icon and the mouse has to be moved
precisely to each of the active areas. This presents difficulties to pupils who can’t control a
mouse or move a pointer accurately, so later on we will be looking at modifying our talking
book to allow access from a keyboard, switches or an overlay board. 

Before you start...
Before you start gathering together piles of books to convert, be aware that putting together
even a single talking book will take time. Creating a template (a master page that contains the
page format and the buttons for turning the pages and listening to the words) at the outset
will save hours of time when making a number of books, but even if you only intend to make
one, do create a template first. 

We are splitting the process of making books into two stages:

Getting your resources together (Part 3)
• How to create or scan pictures for your talking book
• How to save your resources in one folder on the computer.

Assembling your books (Parts 4, 5 and 6)
Here you will learn how to create and load templates, how to put together the actual talking
book by adding pictures, symbols, text and sound, and how to enable access to the talking
book using switches or an overlay board.
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Part 2:
Important! 
The copyright issue

There are obviously copyright considerations involved in reproducing pages from printed
books. The publishers of the books used to illustrate this guide have all given express permis-
sion for them to be converted into multimedia by the addition of symbols, as long as copies are
not sold, and the copyright line on the book’s cover is included in the talking book.

There are some guidelines (as of Sept 2001) on copyright issues on the World Wide Web at:

www.pls.org.uk

These are reproduced below. Take particular note of the text in bold (our emboldening),
which sanctions the creation of multimedia copies of books for the personal use of individuals
with visual or physical difficulties. The creation and use of multimedia copies of books for
school and class use by people with special educational needs in schools still seems open to
interpretation. If you are in doubt, contact the publisher, but check that they are aware of the
new guidelines as they may well help your case. 

Joint Industry Guidelines
These guidelines cover access to books, magazines and journals by visually impaired people.
They do not constitute legal advice but are for guidance only:

Introduction 
a These Guidelines are the result of a wide-ranging consultation among rightsholders and

organisations helping visually impaired people in an effort to strike a balance between
the requirements of visually impaired people and the special problems surrounding
uncontrolled copying, transcription and distribution. 

b Rightsholders including authors, their agents and publishers wish to make their works
accessible to all members of the public. 

c Where visually impaired people cannot read works in formats commercially available
they will in some cases wish to copy, record or transcribe the works into a format accessi-
ble to them. The issue of who may create and distribute copies in different formats, in
particular electronic copies, is important for rightsholders. 

d These Guidelines have been drawn up to assist visually impaired users and those acting
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on their behalf to understand current trade practice with regard to acts of copying they
can assume they are allowed to do without requesting prior permission from the rightsh-
older, provided the conditions described below are met. In case of doubt users should
always consult the rightsholder. 

e Rightsholders support the work of charities and volunteer organisations in making books
and journals accessible to visually impaired people. The permissions they require to dis-
tribute such works are outside the scope of these Guidelines. 

f For the purposes of these Guidelines visually impaired people are taken to include blind
and partially sighted persons, those whose sight cannot be improved by the use of cor-
rective lenses, those who are unable through physical disability to hold or manipulate
books or to focus or move their eyes or who are otherwise physically unable to use avail-
able published formats. 

Guidelines
1 Visually impaired people who have lawfully obtained a copy of a published work,

whether bought or borrowed, may make whatever transcription, copy or format changes
they require to enable personal access to the work, including speech synthesis, Braille,
Moon, large print, single voice recording (speech), electronic file, provided the work is not
readily commercially available in a suitable format. 

2 Visually impaired people may ask another person or organisation, including schools,
libraries and charities, to create an accessible copy on their behalf, provided that any
such copy is made for the personal use of the visually impaired person concerned only.
This includes use for the purpose of work or study.

3 A non-electronic copy e.g. single voice recording (speech) or a Braille copy may be bor-
rowed or exchanged among visually impaired people as if it were the print original itself. 

4 Electronic copies may be created and stored on a computer system for as long as
required to enable personal use of the work while the original is retained. They may not
be made accessible or passed on to a third party or posted on an Intranet, in newsgroups
or on the World Wide Web. If the original is lent, sold or given away, then any accessible
copies and associated electronic files must be deleted or transferred with the original. 

5 Visually impaired people must respect the literary and artistic integrity of the work
including any copyright notices and any moral rights the author may have in the work.
They must not in any way adapt, edit, alter, amend or distort the work, other than as
required to enable full access, without the prior permission of the author or his or her
designated representative. 

6 The copyright remains with the copyright owner. Rightsholders retain the right to
exclude the use of certain formats in special circumstances and permission must be
sought for such use from the relevant rightsholders. 

The development of these guidelines has been supported by: 
Association of Authors’ Agents, Association of Learned and Professional Society Publishers, Authors’
Licensing and Collecting Society, Copyright Licensing Agency, Music Publishers Association, National Union
of Journalists, Publishers’ Association, Publishers Licensing Society, Periodical Publishers Association, Scottish
Publishers Association, Society of Authors, Writers’ Guild of Great Britain.
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You will first need to prepare most of the resources for your talking book. This entails:

1 Creating a folder on the computer in which to save all your resources
2 Creating pictures for your talking book

Creating a folder for your resources
Each completed Powerpoint talking book file stores all its resources (ie pictures and sounds)
within itself. This has the advantage that you will only need to copy this single file if you want
to transfer it to CD or another computer. However, we strongly recommend that you keep all
your separate picture and sound files, along with the talking book file itself, together in one
folder. They can then be located easily should you need to reuse any of them or create the
same talking book using different software. You need first to decide where you want to create
a new folder to put your resources. Two good options are in My documents, a folder that is
already on most computers, or by creating a new folder on the Windows desktop.

1 Open the My documents folder from the Windows desktop screen:

2 On the File menu, Click on New, and then click Folder:

Part 3:
Getting your
resources together
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The new folder appears with the temporary name "New Folder":

3 Type a name for the new folder, and then press Return on the keyboard. 

Alternatively you could create a folder on the Windows desktop screen by clicking anywhere on
the screen with the right-hand mouse button and then clicking on New, then Folder:

Rename the folder in a similar way to the first method.

Creating pictures for your talking book
There are a number of sources for your pictures. You can scan them from a book using a
flatbed scanner, use digital camera photographs, or use clipart and graphics from the comput-
er. We will look at using these three sources in turn:

Scanning pictures
Scanners can be purchased for as little as £50 and some computer sys-
tems already come with one. They work by moving a row of light recep-
tors slowly down the page or picture to be scanned. A certain proportion
of the light is reflected back from the picture which then produces an
electrical signal, building up an electronic image of the page. All scan-
ners use the same standard software to interact with the computer in
Windows called Twain.

You can scan in pictures using software such as PaintShop Pro, Adobe PhotoDeluxe and
Irfanview. In the File menu there will be an option to Acquire an image from a Twain picture

A desktop scanner



ge
tti

ng
 yo

ur
 re

so
ur

ce
s t

og
et

he
r

7

second version december 2001

source such as a scanner. Choosing this option will start your scanner’s software, and you can
then preview and scan parts of a picture. Irfanview is an freeware program that can be down
loaded from http://www.irfanview.com

1 Opening your scanning software
To operate a scanner in Irfanview, click on File and then Acquire:

Acquire opens the scanning window

To find Acquire in PaintShop Pro, click on File, Import, Twain and then Acquire:

Choosing Acquire will open up the scanning window. This will be slightly different for dif-
ferent models of scanner and their software.
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All scanner software will have Preview and Scan buttons. When you press the Preview
button, you get a quick mini-scan of entire scanner bed. Using the mouse you can drag
out a rectangle on the preview image and mark the area you want to scan. You can fur-
ther adjust the size and shape of this area by clicking on and dragging any of the six
small blocks on the edge of the rectangle. Don’t click the Scan button just yet.

2 Picking the best resolution for your scanned pictures
Somewhere on the settings screen of all scanning software there will be an area where
you can specify the Resolution (sometimes called Output Resolution) for your final scan.
The higher the resolution, the larger the file size of the scanned picture, so generally the
scanner’s resolution should be set at 72dpi, unless you are scanning a particularly small
picture that may have to be greatly enlarged when it appears within your talking book. In
this case, specify 150dpi. Scanning at a higher resolution only creates extra information
that the screen display will ignore, and slows down the displaying of the images.

There are lots of other controls you can change in the scanning software to alter the
quality of the image. You can alter the Gamma, Saturation and Hue of your scanned
images, but unless you have a great deal of time, I would recommend that you leave
these controls alone and just use the default settings. 

3 Scanning your pictures
Click Scan to scan your image. After the scanner has finished, your image will appear on
the screen.

4 Picking the best file format for saving your scanned pictures
When you save your scanned picture on the computer, it is important to choose the right
format for them. The format can have a very significant effect on the amount of space
your scanned picture file takes up on the computer. You can usually find the list of for-
mat options by clicking Save As in your scanner software. If not, try Export if it exists.

• For scans of illustrations or photographs, choose JPEG.  



ge
tti

ng
 yo

ur
 re

so
ur

ce
s t

og
et

he
r

9

second version december 2001

• For scans of symbols, black and white line drawings, or cartoons containing solid 
blocks of colour (like the Mr Men books), choose GIF, although JPEG would be OK as 
an alternative.

Your software may offer you a default option of Windows bitmap (BMP), but this is not
generally recommended for talking books, as scans in this format will produce much
larger files. Powerpoint will display jpegs, gifs and bmp pictures.

If you want to name your scans numerically, use 01, 02, 03 .... 09 for the first nine files
rather than 1, 2, 3. They will all then be listed before file 10 in your file windows.

I would recommend scanning in all the pictures from any book all in one session, and
save them as picture01, picture02, etc. Scanners are temperamental machines and once
started, I have found it better to go through to the end. 

Using digital camera pictures
The use of digital cameras in schools has recently increased considerably due to the advances
in digital camera technologies (they have become much cheaper, with better picture quality
and faster downloading of the photos onto the computer). Digital camera pictures can be
incorporated into talking books in the same manner as scanned images. After downloading
your pictures onto the computer using your camera’s software, they can be treated the same
as any other computer graphic.

Using clipart or pictures from the computer
You will probably find a large number of pictures already installed on your computer (Microsoft
Office, for example, comes with a good number of clipart pictures) and you can get many more
pictures and graphics (of varying quality) on commercial CD-ROMS. All can also be incorporat-
ed into your talking books. The Internet can also be a source of picture files (for example
www.clipart.co.uk or images.google.com), and the CALL Centre (callcentre.education.ed.ac.uk)
produce a useful list of clipart websites.

Creating symbols for your talking book
Symbols can be added to support the text of your talking books. Sources of symbols include the
Writing with Symbols CD (from Widgit Software), Inclusive Writer (from Inclusive Technology),
Clicker (from Crick Software), and Intellipics (from Intellitools or Inclusive Technology).

Although you can create and store graphic files of symbols sentences in the same way as the
main pictures, it’s easier to paste the symbol sentences directly into the Powerpoint pages
while you are putting together the talking book itself. So leave this for now - the process will
be outlined later.



ge
tti

ng
 yo

ur
 re

so
ur

ce
s t

og
et

he
r

10

second version december 2001



cre
at

in
g 

a t
al

ki
ng

 b
oo

k t
em

pl
at

e

11

second version december 2001

The first stage in the construction of a talking book within Powerpoint is to create a page tem-
plate that you can use for all your books. The instructions given here are based on Powerpoint
2000 but Powerpoint 97 has broadly similar controls and capabilities. 

1 Create a blank page
From the File menu in Powerpoint, click New and double click on Blank Presentation:

Choose the blank page in the bottom right hand corner and click on OK:

Part 4:
Creating a talking
book template
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2 Add the page turning arrows
To add a forward page turning arrow to the blank page, select the SlideShow menu and
click on Action Buttons:

... and a small cross will appear in the blank page instead of the mouse arrow. Position
this cross with the mouse at the bottom right hand corner of the page and click the
mouse.  The forward arrow button will appear where the cross was positioned and the
Action Settings box will appear:

Click on OK. You can adjust the size and position of the arrow button using the mouse.

Add the back arrow button in a similar manner by choosing Action Buttons from the Slide
Show menu and selecting a backwards arrow:

Click on the forwards arrow ...
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Position the arrow on the page as before. When the Action Settings box appears, click OK:

3 Adding a page turning effect
You can make the next page slide in from the right...

... by clicking on Slide Show...

... and clicking on Slide Transition...

... then choose a transition effect (eg Cover Left)...

... and click on Apply to All:

4 Don’t add the speaker button yet
The speaker/sound control button is best set up afresh on each page as you create your
talking book. It is better not to create it in the template file.

You now have a slide that can be made into a template file for each page of your talking book.
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5 Save the slide as a template
To make this slide into a template file, click on File, then Save As and then on Design
Template. Click in the File name box and give it a name, eg ‘talking story1’:

The template, in this case called ‘talking story1’, will now be available from the New
Presentation menu whenever you start a new file in Powerpoint. You can use the tem-
plate to create your talking book.

The talking story1 template
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We will now create a talking book using the template page (called a slide in Powerpoint). If it is
not already open, start Powerpoint, click on File, then New and open your template.

Creating blank pages from the template
Powerpoint has a number of control icons at the bottom of the screen that allow different
views of all the slides.

normal view

slide sorter view run a slide show

We will use the Slide Sorter View and Normal View to show all the slides (or pages) in your talk-
ing book as you create them.

Part 5:
Using the template to
make a talking book
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To create the correct number of blank pages required for your book, highlight the blank slide in
the slide sorter window by clicking on it once. Then press CTRL and D together as many times
as you want blank pages for your book. It is easy to add or delete pages at any time.
These slides will automatically be linked to each other by the forwards and backwards arrows
on the blank pages.

Adding pictures and symbols onto a page
There are two ways of adding graphics to Powerpoint pages: Inserting and Pasting. We will be
inserting the page scans, then creating, pasting, and cropping the accompanying symbol sen-
tences.

Inserting the scans
To add the picture files containing the scanned page images, do the following:

1 Choose the picture to insert
Click on the Insert menu, then Picture, then From File and choose a picture that you have
previously scanned into your computer:

Clicking on From File opens a window on your computer where you can choose a picture.

Slide sorter view

Normal view



us
in

g 
th

e t
em

pl
at

e t
o 

m
ak

e a
 ta

lk
in

g 
bo

ok

17

second version december 2001

2 Place the picture on the page
Click on the picture you want for your first page and then click on Insert. This will put the
picture onto the first blank page. You can resize it and position it on the page by clicking
and dragging on the corners of the picture frame.

Creating and pasting the symbol sentences
Symbols can easily be added to support the text of your talking books. Sources of symbols
include the Writing with Symbols CD (from Widgit Software), Inclusive Writer (from Inclusive
Technology), Clicker (from Crick Software), and Intellipics (from Intellitools or Inclusive
Technology). To add symbol sentences you will need a copy of the symbol writing software.

1 Write your sentences into the symbol processor
Amend or choose the symbols as you want using the controls within the Symbol proces-
sor and thicken the lines to at least size 2. It’s best to make your sentence fairly large, but
not so large that the end of it extends beyond the bottom of the screen.
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2 Capture the image that’s on the screen
Move the cursor off the screen by pressing the Return key a couple of times. Then hold
down the ALT key whilst pressing the Print Screen key to capture an image of the screen
(the Print Screen key is usually towards the top right-hand side of the keyboard before
the numeric keys; it may be called Print Scrn or PrtScr). Although nothing will appear to
happen when the keys are pressed, an image of part of the screen (called a Screen Dump)
is stored temporarily into the computer’s memory, ready for pasting.

3 Paste the screen image into Powerpoint
Go to the page in your Powerpoint talking book where you want the symbol sentence to
be, and choose Paste from the Edit menu (or press CTRL and V together on the keyboard).
The screen image that you captured in step 2 should appear on the page, probably at the
wrong size, and in need of trimming.

Cropping and resizing the symbol sentence images

1 Crop the image
Clicking on your pasted image should bring the the Picture toolbar onto the screen, but if
it doesn’t, choose Toolbars from the View menu and select Picture. Make sure the image
is selected by clicking on it, then choose the Crop tool from the toolbar:

When you move your cursor over any of the small white boxes on the frame of your
image, it will become a crop symbol. Hold down your mouse button on the relevant
frame box and crop the image by dragging a relevant corner or side inwards, then release
the mouse button. You will need to reselect the Crop tool each time you want to carry
out a further crop.

2 Resize the image
You can resize your image if necessary by clicking and dragging on its corner frame
boxes. You can reposition the image by clicking anywhere within it and dragging it to the
new position.

The Crop tool in the Picture toolbar
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Adding speech to a slide
You can record speech to add to your talking book using a microphone plugged into the com-
puter’s soundcard (all multimedia computers will have a soundcard). Plug the microphone into
the microphone socket in the sound card at the back of the computer. Although Windows
comes with its own sound recorder in the Entertainment folder, accessed from Accessories in
the Start menu, there are sound recording controls within Powerpoint. We will be using these.

Wait! Before you start adding speech or sounds... 
There is one very important change you must make to Powerpoint before you start to add
sounds to your talking book. This is because Powerpoint stores sounds in two different ways:

1 If the sound file is small (ie there is not much speech), the complete sound will be stored
within the Powerpoint pages.

2 When the sound file is large (ie contains a lot of speech and/or music), only a link to the
sound file is stored, and not the sound file itself. This can cause problems transferring the
talking book between computers. You will get a silent talking book!

What we need to do is alter the settings within Powerpoint to allow larger sound files to be
stored within the Powerpoint pages, thus avoiding these problems.

1 Click on Tools, then Options:

2 In the dialogue box, click on General:



3 Click in the Link sounds box with files greater than and type in 50000 (which is the
biggest number Powerpoint will accept):

This will ensure that all sound files smaller than 50000Kb (5Mb) are included within each of
the pages when you save your talking book. If it is then used on a different computer, the
sounds will play correctly. Five Mb is large enough for all your recorded speech files to be
included.

So, now to add the speech...
1 Click on the Insert menu, click on Movies and Sounds and then click on Record Sound:

2 This window will appear:
Click on the red record button and speak into
the microphone. Click on stop at the end and
then click in the Name box. Delete the words
"Recorded Sound" and give the speech a
meaningful name  ("Not me said the parrot"
rather than just “sound1”, or “speech2”). 

Then click on OK.play   stop   record
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3 A loudspeaker picture will then appear in the middle of your page:

This can be positioned wherever you want on the slide using the mouse, and resized by
clicking on and dragging the corners of the frame:

This is the first page of your talking book.

Completing your talking book
Click on the next blank slide either to the left of the screen (if you are in Normal view) or in the
slide sorter window and add the graphic, symbols and sound to create the second page of the
story. Follow the same procedure to make the rest of the pages.

Continue for all the pages in the story
and check them frequently by running
the slideshow:

run a slide show



Finally, set up the show to work only from the forward and backwards arrow buttons. Click on
the Slide Show menu then Set Up Show: 

Then click in Browsed
at a kiosk (full screen):

Then click on OK.

This setting ensures
that the pages only
advance when the
arrow keys are clicked
and the slideshow
doesn’t respond to
any other keyboard or
mouse input.

Adding extra sound effects
Sound effects can also be added to liven up the talking books. These can be found from a num-
ber of sources, including the internet. Windows comes with a variety of sounds, as do a num-
ber of other programs. A simple search on your computer will probably reveal a large number
of sound effects (look for files ending in .wav). You can also buy CDs that contain sound effects
- they are often included with clipart and picture CDs.

To add extra sounds from your computer
Click on Insert, then Movies and Sounds and then Sound from File.
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Combining a page turn with speech
It is possible to set up your Powerpoint talking book so that a single mouse or switch press will
turn the page and speak the text. To do this, the speech and page turn need to be combined on
one button.

Go to the Slide Show menu and click on Slide Transition:

Click on the Sound box where all your
pages’ sounds will be listed. Choose the
right sound for the page and click on
Apply, not Apply To All. Once again the
importance of giving the sounds a mean-
ingful name really pays dividends here.

Do this for all the pages.

Adding a time delay to a page turn
A further very useful addition to the single press modification described above is to give the
forward arrow a timed delay. This prevent users with a tremor making rapid switch or mouse
presses that would otherwise cause the pages to fly past.

1 Click on the arrow button on the page with
the right mouse button.

2 Click on Slide Show, then Custom Animation:

The dialogue boxes for the final steps differ significantly between Powerpoint 2000 and
Powerpoint 97, so we’ve shown both over the page:



3a If you’re using Powerpoint 2000, click the Action button box...

... and choose Appear
in the Entry anima-
tion and sound win-
dow.

Click on the Order & Timing tab, and select Automatically in the Start animation box. In
the box underneath choose a time delay by using the up/down buttons. We would
advise using 00:02 seconds. Click on Ok.

3b If you’re using Powerpoint 97, click the Action button box and choose Appear in the Entry
animation and sound window.

Click on the Order & Timing
tab, and select Automatically
in the Start animation box. In the box underneath choose a time delay by using the
up/down buttons. We would advise using 2 seconds. Click on Ok.
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Part 6:
Enabling access with
a single switch

There is no easy way to add direct switch access in Powerpoint so that people who can’t use a
mouse can access your talking books. Although you can use utility software like Clikit (from
Intellitools) to create ‘hotspots’ on the page which can be controlled with a switch, results can
be unpredictable. You can, however, connect a single switch to operate the combined speech
and page turn button. 

Position the mouse cursor over the page arrow and attach a switch using either a mouse
switch box (Semerc Mouser or Tash MouseMover) or a keyboard switch interface. The keyboard
switch interface must be set to send a mouse click (This is possible, for example, with a Don
Johnson keyboard interface, an Inclusive Technology keyboard switch interface, or a switch
attached to the Intellikeys keyboard).

Position the mouse cursor over the page turn arrow

You should now be able to operate the talking book using a single switch. Make sure that the
cursor remains over the arrow!
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Part 7:
Getting creative with
talking stories

Perhaps one of the most exciting activities involved in making talking books is the creation of
new stories with pupils. These stories can be developed using the pupils’ own language and
can incorporate their own choices. This allows those with learning difficulties real access to
shared and creative writing. 

Commercial talking books with a simple interface are usually targeted for very young chil-
dren with age-appropriate language and topics. There are few talking books on a more adult
level that have the same simple interface.

The books that you create for your own pupils can be on more adult themes. It is possible to
incorporate feelings and activities that reflect young adults’ interests, while keeping the sim-
plicity of layout and control that pupils with learning difficulties need.

There are obviously many different methods in transferring pupils’ ideas and creative writing
to the computer. One method is to start with a story page planner sheet:

Name: Date:

Title:

Picture

text/symbols

Sounds/animation
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Pupils can build these pages into a storyboard, planning out their book by constructing the
individual pages.

I have found it most successful to use a ‘story starter’ that is based on either from a real situ-
ation or the continuation of a story line from a book. 

For example, here is the opening line taken from Metamorphosis by Franz Kafka:

You can develop the storyline by first asking some simple questions, shaping the story from
the pupils’ answers.

• How would Greg feel?
• What would he eat?
• How would he get out of bed?
• What would his family feel?

In this way the story can be developed, in the style of Franz Kafka, with creative writing gen-
erated by the pupils.

Another story we have made into an accessible symbol and talking book on the computer is
The Iron Man by Ted Hughes. You may wish to consider making your own talking book of this
story. The opening chapter from The Iron Man is not only an excellent piece of imaginative
writing, but it contains most of the elements that make for good shared reading; relatively
simple language, repetition, imagination, and well written, almost poetic, prose. It also has the
benefit of a story tape read by Ted Hughes himself that you can use alongside your computer.

All sorts of methds, including Rebus choice sheets and story cubes, can give pupils using AAC
communication methods access to imaginative creative writing. As always, the emphasis is
best put on possibilities, not barriers.

Enjoy your creative writing!
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